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Welcome

Welcome to DigiGuide, the UK's best Interactive TV Guide

DigiGuide enables you to personalise your own TV guide, perform fast searches and set up 
reminders so you never miss your favourite programmes. 

This Guide provides instructions on using the main DigiGuide features to help you get 
started. The        arrows relate to specific tasks to illustrate our features.    

The Guide covers just a preview of what you can do with DigiGuide. For more advanced 
features, please refer to our on-line tutorials at www.digiguide.com and click on Support.

If you have a technical questions, please use our on-line technical support.

If you have any comments you would like to share, please use our forums by 
clicking the community link on our web page. 

May we take this opportunity to thank you for using DigiGuide.

The DigiGuide Team

Copyright ©1999-2005 GipsyMedia Ltd. Reproduction of material without prior written permission is strictly 
prohibited. 
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System Requirements

Minimum System Configuration

If your system does not meet any one of the following minimum system requirements, 
DigiGuide will not run properly.

Microsoft® Windows 95/98/2000/NT/XP
10MB free uncompressed hard disk space
16-bit Windows-compatible sound card (if sound alerts are required)
Internet connection.
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Installing DigiGuide

Installing DigiGuide

From our DigiGuide web page (www.digiguide.com), double-click on the Download a Free 
trial Now icon. This will take you to a page where you can set up your account preferences. 
Click on the download link again. 

On the File Download window, click Save and select Desktop from the pop down list, then 
click Save. This will start to download DigiGuide.

Once downloaded, close your web browser. 

On your desktop, you will see your DigiGuide Installation file. Double-click to start the 
installer after agreeing to the terms and conditions. 

Step through the DigiGuide wizard leaving all the options unchanged and click finished. 
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Installing DigiGuide

Once installed, DigiGuide will automatically start with a DigiGuide Set Up wizard on 
screen. This wizard will help you to configure your DigiGuide. 

Sign in with your account information when prompted.

Select United Kingdom - and click Next
Select your region - and click Next
Select your provider - and click Next

This will take you to the Customise Lineup window where some channels are pre-
selected according to the region and provider selected above. Check the channels and click 
Next.

This will take you to a Viewing Preferences window to automatically highlight
programmes in your DigiGuide.

Select how much you like each of the categories and click Finish. Alternatively, leave the 
options as they are so no programmes are automatically highlighted. 
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You will then see the Change Your Channels window. 

Scroll down the list on the right column (your chosen channels) and remove the
channels you don't want by double clicking with the left mouse key. You can also add
more channels. 

Click OK when finished and DigiGuide will automatically start downloading 
listings for you (note: you must be on-line). You are now ready to use your DigiGuide. 

Read on to configure your own TV listing or select Quick Start tutorials in the Help
menu to access quick video lessons. 

Uninstalling DigiGuide:

To uninstall the program, proceed as follows: 
1. From the taskbar, click on Start and select Control Panel
2. Double Click on Add or Remove Programs icon
3. Scroll down to DigiGuide TV Guide and click on this option
4. Click on Remove
5. Follow the on-screen instructions to complete the uninstallation.

Installing DigiGuide
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Getting Started

Getting Started

You can start your DigiGuide by clicking on the DigiGuide TV Guide icon on your 
All Programs windows menu or the link on your desktop.

You can also set up DigiGuide to automatically start when you start your PC (this will 
enable the reminder functions, introduced later on). To do this, select Customise on the 
Tools menu, select Startup and make sure the box is ticked. 

By default, you will have the following screen – The Welcome (please note some of
the colours, channels and  programme information could be different as they are 
automatically linked to your programme preferences given during set up). 
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Updating Programme Information

How to access your DigiGuide features?

There are three methods of accessing features within DigiGuide, the menu bar , the tool 
bar and the explorer bar . We will refer to these in this manual.

Updating your Programme Information

DigiGuide provides an ideal listings and software update mechanism. It can be completely 
silent or it can inform you of everything is does. To set up your Auto-Update, simple choose 
Customise from the Tools menu and click the Auto-Update in the list. Select your options.

To update your listings you can click on the Update icon on your tool bar (or press F5) at 
any time. 

Please note, although DigiGuide works off-line, you must be on-line to perform the updates.
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Tool Bars

Print. To print a selected view.

Welcome View (default view). View featuring programmes now 
and next

MyTV View. To access your own personalised TV guide created by 
all your markers and preferences.

Multi-channel Grid View. That's where you can see all 
programmes on multiple channels at the same time.

List View. To view programme information by channel, in a 
traditional newspaper-style vertical layout.

Listing Update. Click if you want to update your listings with the 
most up to date information. You must be on-line.

Help. This icon will connect you directly to our on-line tutorials.

To perform a search. Type a programme type, name, actors, part 
of the description, etc.. and it will search the schedules for you.

To mark a programme to watch. When selecting this icon for a 
selected programme cell, it will mark it so you can easily see what 
you want to watch.

To set a reminder for a programme. When selecting this icon 
for a selecteed programme cell, it will automatically mark it so you 
can get an alert when the programme is about to start.

To mark a programme as favourite. When selecting this icon for 
a selected  programme cell, it will automatically mark it as a 
favourite.

To launch the Highlighter Wizard. This will enable you to 
quickly and easily highlight a type of programme, a
programme name or even an actor.

PURPOSEBUTTON

The following table provides you with a description for each tool bar icon in 
DigiGuide.
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Updating Channels Information

Updating your channels at any time

When you installed DigiGuide, you selected the channels for which you wanted to view 
programme information. You can add or remove channels at any time.

To delete channels

Right click on a channel logo and select Remove this channel to delete this channel from
your line up. Please note, you must be on "The Multi-channel Grid" or "By Channel" view 
modes.

To add channels

Right click on any channel logo and select Add a new channel to display the Change your 
Channels window.

From this window, you will be able to add and remove any channels from your line up and

even change your country or provider. You can also perform more advanced options as

sorting your channels and creating groups. Alternatively, you can access this window by 

selecting Change your Channels on the Tools menu. 

Whenever we add new channels in DigiGuide, you will be asked if you wish to add them to 
your channel selection during your update.
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Panel Bar

Panel Bar

The Panel Bar is a very useful tool. It contains some handy
tools and quick ways to find out information like what’s on
now and next. 
If it doesn’t appear on the right, choose Show Panel Bar
from the View menu.

You can remove sections of the panel, or change their 
order, by right-clicking on the heading of the panel section
and using the popup menu options.

Panel Calendar
The Panel Calendar provides a quick view through the days. 
You can see at a glance the days that have TV listings 
available marked in bold.
Change the month by clicking the arrows on either side.
If you click a day, DigiGuide will switch to that day. 
The current day has a red outline.

Tip of the Day
Navigate through the Tip of the Day, you might find a nice 
feature that you were not aware of!

Hotlinks
To  find out more on any programme, use one of the 
Hotlinks and get on the net.

Legend
To view any previously created markers and search quickly 
and easily by pressing the right mouse key on any item.
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Performing Searches

Quick Programme search

One of the major advantages of DigiGuide over a paper-based alternative is the ability to
search for programmes. This powerful feature allows you to find any text within
any area of a programme's details.

How can I find all gardening programmes? 

Type your search phrase, for this example “gardening” into the search box on the toolbar 
and click Find. The DigiGuide Finder window will instantly display the results. 

The quick search is an easy way to check if a favourite programme, actor, etc. appears in 
any schedules. In addition to searching forwards, you can also search back through the TV 
listings on your computer by ticking the Include old listings in search option.
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Performing Searches

Advanced searches

You can also perform more powerful searches using keywords.

How can I find all new gardening programmes with Monty Don and print the 
information? 

Type gardening AND monty don AND NOT repeat in the search box and click Find
(please note that the qualifiers (e.g. AND) don’t have to be in upper case, this is just to
highlight their usage). Click on the Print icon.

By default, the Finder window doesn’t show descriptions, but these can be displayed by 
ticking the Show programme descriptions check box at the bottom left of the window. 
In addition, by double-clicking on any programme, the InfoPopup window for that
programme will be displayed.
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Performing Searches

View recent searches

You can view your recent searches by double clicking on My Recent Searches in your
explorer bar. 
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Creating Markers

Creating  Markers

One of the most useful facilities of DigiGuide is its ability to “mark” a programme so you can 
see at a glance all your favourite programmes.

There are different “types” of markers:

Favourite: to highlight your favourite programmes

Reminder: to set up reminders about specific programmes

Watch: to get  a list of all the programmes you want to watch 

Video: to get a list of all the programmes you want to record

Category: to highlight a programme by setting the background colour 
and/or displaying an icon

Manually created: this allows you to create your own criteria for highlighting 
programmes and how they are marked (explained in the next section).

The three ways to mark and highlight a programme

1. Select the programme you want to mark and click one of the toolbar buttons:

2. Right click on the programme you  want to highlight and choose one of the menu 
commands:

3. Choose Create a new marker from the Edit menu (for more advanced options) – see 
next section



17
User manual - version 2 - release date: 28/04/05

Creating Markers and Setting Up Reminders

Creating a new Marker

How can I see at a glance all movies featuring Kevin Spacey and get
reminders ?

From the Edit menu, select Create a New Marker

That will take you to the Create a New Marker box. First you need to give the marker an
individual name so you can easily recognise it. For the purpose of this example, type "Kevin
Spacey".

As we are not searching for a specific programme, we can leave the box on the Programme
Name empty.
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Creating Markers and Setting Up Reminders

Next, click on the Channels tab. As we want to search every channel, we make sure that all
the boxes are ticked. If, however, we wanted to select particular channels only (e.g. Sky
Box Office Movies), we would have clicked Select none and clicked the tick box for the
appropriate channels on the list. 

Next, click on the Categories tab. As we want to search for films only, we first click Select
none to clear all the tick marks, then tick "Film" only. You can also select other categories 
as TV shows, documentary, etc… or keep all the options ticked.
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Creating Markers and Setting Up Reminders

The next tab Display will allow you to set the way you would like your marker to display on
your programme grid. You can select the background colour (for example Yellow) and add 
an icon if you wish by selecting the tick box on Use Icon and  typing 
"%DGDIR%client01.exe" into the box, then click on Browse to display all of the icons
available within DigiGuide. Choose any one you want and click OK.

The Expression tab is crucial and will allow you to qualify your selection by searching a
specific feature which would be within the programme description.
For example, type (“4 Star” OR  “5 Star”) AND premiere AND Kevin Spacey into the
box to select all premiere movies rated 4 and 5 stars with Kevin Spacey 
(note, this is not case sensitive). Make sure that only the description option is ticked. 
As our search is about Kevin Spacey, it is essential to type his name in this box.
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Creating Markers and Setting Up Reminders

As we want to find any programme at any time, we make sure that only the any time
option is selected on the Time tab. Alternatively, we could limit our marker search to a
time range or days by selecting the appropriate options.

Setting Up Reminders
Finally, we want to make sure that we don’t miss any programmes DigiGuide finds for us, so
in addition to the specific display on the programme grid, we would like to set up a reminder
option. Click the Alert tab and tick Enable alert. Then select how long before the
programme starts you would like your reminder to appear (minutes, hours, days or
weeks). Tick On-screen warning and even Speech alert if you wish your computer to talk
to you! You can type whatever phrase you wish but you can’t change the voice! 
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Creating Markers and Setting Up Reminders

Click Add Marker to save your settings and exit.

You will now notice that your markers have been implemented and are displayed as you
marked them when the next programme is on.

Reminders will pop up and let you know all information you need about the specific
programme you selected: Name of movie, when it is on, channel, cast and programme
description. This information box also contains links you can click on to find out more
information. 
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Show Me All View

Show me all

If you click for example on the Kevin Spacey link, you will automatically display
a show me all view of all programmes broadcast featuring Kevin Spacey in your TV listings
for your selected channels.

The light shaded text marks programme which have been shown already. This list will show
all programmes without any constraints that you may have sep up with your markers (i.e.. 4
stars, widescreen, premiere, etc..).

You can also access the Show me all view by right clicking on any programme.

You can click on any of them to display the full programme description.
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Customising your own TV guide

You can have full control over the channels in DigiGuide as well as their order and the
names of the channel groups. In this section, we will take you through the various steps so
you can customise your very own TV guide.

How can I view my programme information?

You can view your programme information in three formats. Choose by clicking the 
appropriate icon on the tool bar or select from the Explorer bar.

1. The Multi-Channel Grid view

This is the view by default when you first install your DigiGuide. If you want to browse your
television or radio listings then this view is the one to use. The grid is similar to most
electronic TV guides found in many satellite and cable systems.
You can see several hours of listings across several channels at the same time, providing
an instant capability of finding out what's on at a particular time.

2. Single Channel List view

By clicking on the By Channel icon on the Explorer Bar, you will display a list of 
programmes for a particular channel in a familiar vertical newspaper style format. To select
the channel you want, click on the channel logo (in the channels column) and the list will 
automatically change to display all programmes for the day for this channel.
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Customising your own TV guide

3. My TV

If you want a summary of your interesting marked programmes across all selected 
channels then this is the view to use. The My TV displays all programmes highlighted by 
one or more of your markers.

There are three elements to the display: the Programmes List, the Filter Area and
the Timeline.

The Programmes List
This section contains a list of all programmes for the current day that have been 
highlighted with a marker. Each programme is on a new line and detailed information is 
provided in the content of the columns (date, time, channels, etc..).

The Filter Area
To allow the content of the programmes list to be filtered based on the type of markers.

The Timeline
This area shows a convenient mini-grid of important programmes so you can see quickly 
and easily if any clash with each other.
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Print your own TV Guide

Printing your own TV guide

The printing system in DigiGuide is simple and powerful.

Select Print This View from the File menu and choose how many days you want to 
print or click the options link if you want more power over your printouts.

You can print multiple days - just give a date and the number of days to print. 
Some of the power options allow you to do things like choose to include programme
descriptions or not, or select programmes with specific markers only.

The printing templates that ship with DigiGuide provide a basic printing system that is 
useful and informative. However, you can choose different print templates by clicking on
Get more templates. You will be re-directed to one of our web site's pages called 
DigiGuide Print Templates (please note, you need to be on-line). Sort by Times 
Downloaded to find the most popular templates,  then select one by clicking
Download this DigiGuide Print Template now! Select Save for the File Download
window. Once downloaded, the new template will appear in the appropriate print view.

Note: These templates are not created or supported by DigiGuide, so if you have any
problems or questions, please contact the author. 

How can I print a list of all Dramas featured in the evenings for the next 14 
days?

Select By Category in the Explorer bar, and click on Drama. You will get a list for the 
selected day. 

Right click on any one of the programme and select Highlight all Drama 
programmes.

Go to MyTV view.

In the Filter area ( ), select Customise your filters.
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Print your own TV Guide

Click on New and give a name to your filter (e.g. "All Drama"). Click OK and close.

Next, go to All Markers in the Filter area, and select your newly created marker - in 
this case All Drama.

Click on the Print icon in your tool bar to display the Print My TV Guide View. 
Click Show customise options.
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Print your own TV Guide - con'td

Select Only special programmes. 

Ensure that only Category is selected (uncheck any others).

Select your evening time in the time filter. For this example,  from 17:00 to 23:00
for both weekend and weekdays. 
You can select different time ranges for the weekdays and weekends if you wish.

Type "14" in Days to print box.

Click Print.
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Print your own TV Guide - con'td

DigiGuide will automatically send your document to print.

(sample extract)
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Customising your Display

How can I customise the way my channels are displayed?

Select Customise from the Tool menu to open the Customise DigiGuide dialog 
box.

The Customise DigiGuide dialog box gives you a list of options on the left hand side column. 
By navigating through these options, you will be able to: 

• Change the General Settings with an option to set up your DigiGuide to go straight to 
your prime time when starting up

• Customise your Display: change the colour scheme and increase the font size for all 
the DigiGuide interface

• Customise your Grid: to select the level of information you want to display in your grid

• Customise your Listings Views: where you can select to have your listings views set up 
as newspaper style and what information should be included.

• Customise your Start Up, Auto Update  and Alert settings; plus more advanced settings 
for internet connection and web service.



30
User manual - version 2 - release date: 28/04/05

Customising your Display

For the purpose of this example, we will show you how to customise your display settings. 
Click on Display and choose a colour scheme from the drop down menu.

You will notice that DigiGuide will immediately implement the changes so it’s easier for you 
to choose the one you like.

If you want more options, click on Get more schemes…. You will be directed to one of our 
web site's pages for DigiGuide Schemes.

By selecting Sort Items and Times Downloaded, you will see the most popular user
schemes.  If you like one, just click on Download this DigiGuide Scheme now! By 
opening the file in the File Download dialog box, you will automatically update your
DigiGuide.

Note: These templates are not created or supported by DigiGuide, so if you have any
problems or questions, please contact the author. 

If you want to go back to your original settings, you can click on one from the Customise 
DigiGuide options again and it will update.
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Displaying Large Fonts

How can I increase the font size?

Choose the Customise command from the Tools menu, select Display and tick the option
Use large fonts in DigiGuide user interface. 

That will automatically increase the font size of all the text within DigiGuide.

You can also use keyboard shortcuts. Press the F11 key to automatically increase the font 
size, and press F11 again to revert to the original size.

Or press Ctrl+ PLUS (numeric keypad) to increase the font (the more you press, the more it 
increases) or Ctrl+ MINUS to decrease the font. 

Coupled with the High Contrast display scheme, this feature will greatly help those with
visual impairments.
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Technical Support - Troubleshooting

When I check for new listings, it fails with an error message
OR
When logging in or getting listings I get "cannot request subscription information" 

If you have a firewall, proxy server, or some other internet based application like that, then
you may find it interfering with the communication between DigiGuide and the Internet.

This can cause various problems with error messages when logging-in or getting listings like
"The system cannot find the file specified", "Cannot request subscription information" or 
"Page not found".

Make sure the firewall is configured properly to let DigiGuide access the internet.

Do not disable or uninstall the firewall, this often makes the situation worse. 
If the firewall is a decent one, then it will ask you if DigiGuide is allowed to access the
internet ... say "Yes, always".

I get an error message saying that 'The server name or address could not be 
resolved'

This warning message is usually displayed when you try to Get New Listings and DigiGuide
cannot connect to the Internet through your Internet Provider.

It normally appears if you have a Personal Firewall or Proxy Server stopping DigiGuide
having access to the Internet.

If you have a Firewall, ensure DigiGuide is configured to have full access. If it worked
before, then remove all references to DigiGuide and then try DigiGuide again, agreeing to 
any Firewall messages that appear.
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Technical Support -Troubleshooting

DigiGuide keeps aborting, crashing or just will not start
OR
Some of my listings have blank gaps all over the place, how do I fix this?

It sounds like your local programme database has become corrupt, therefore you will need
to remove it. 

1. Close DigiGuide
2. Open Windows Explorer and navigate to your DigiGuide directory, this is usually 

c:\program files\DigiGuide
3. Select the folder Schedules and press the Delete key
4. Select the folder New and press the Delete key
5. Restart DigiGuide and get listings in the usual way.

When I view listings the text is truncated in each column 

You can resize the column to display more information.

Just click between the two column headings and you will see the mouse pointer change,
then click with the left mouse button and hold whilst you drag the mouse to the right to 
make the column bigger, then just release the mouse button to set the position of the 
column.

My listings are all out of order, like 9pm is before 10am 

The list views in DigiGuide present the programmes in a 'list' style with columns. The
columns that you see can be removed and others added, but not only that they can be
sorted by clicking the appropriate heading. You may be using one of the views other than 
the multi-channel grid.
What can happen, is that one of the other columns other than "Start" time has been clicked

and therefore sorted on, which could make the programmes appear 'jumbled'.

Right-click the column heading and select "Sort->Date" and you should find everything
appears as it should do.
Also, if you move the mouse pointer above the column heading and press the Right Mouse
Key, you will notice a menu of columns appears. Just highlight the column you wish to add
or delete and click with the Left Mouse Key.
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Technical Support - Troubleshooting

All the programmes in DigiGuide are hours out 

We produce the listings in GMT time and DigiGuide then uses the system clock and time
zone settings to make any relevant offsets.

This is used to add on the extra 1 hour for BST but also so DigiGuide displays the
programmes as you would receive them in other countries, i.e. in France.
This explains why your computer Time Zone settings can have a big affect on how listings
are displayed.

To change your Time Zone settings, just follow the instructions below:

1. Double-click the time in the bottom right corner of your Windows screen
2. Click the "Time Zone" tab and ensure that it is set appropriately ("GMT London" or 

whichever is applicable to you) and the "Adjust for daylight savings" is ticked.
3. Click the Apply button
4. Click "Date & Time" tab and change the time on the window that appears to the 

correct time for now
5. Click the OK button
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Customer Support

Customer Support

If you could not find the solution to an issue in our Troubleshooting section, DigiGuide offers 
a variety of support options.

• Press F1 whilst using DigiGuide to reach our on-line support (you must be connected to 
the Internet at the time).

• Open a Support Ticket stating your questions or descriptions of your problems. Our 
customer support will reply to you by return e-mail.

• Contact us via our Forum on our web page. 

DigiGuide is published by GipsyMedia Limited.

First Floor Office Suite 
17 The Strand 
Exmouth 
Devon 
EX8 1AF 
England

Tel: +44 (0) 1395 272555
Fax: +44 (0) 1395 272555
email: info@digiguide.com
www.digiguide.com


